Submit an input file to a digital press using Digital
Submit

Why you should complete this lesson

This lesson provides practical guidance in using Digital Submit and Digital Direct software to
submit a document to a digital press. For the purpose of this lesson, the input file submission
will be made to a managed digital press. The input file will be submitted to the digital press
using Digital Submit. Submission to an RBA rule using Digital Submit is covered in the Submit
an input file to an RBA rule using Digital Submit section.

This lesson provides guidance using Digital Submit and Digital Direct, and is meant to be flexible
to fit your environment and learning needs. It isn't necessary to complete the procedure steps
in this lesson. If you prefer, use the procedure steps as a guide to better understand the
software and how it will operate with your own system.

Print a document on a digital press

You want to print a document on a digital press. Once the document is uploaded to Digital
Direct, it needs to be planned, submitted to press, monitored, and removed following successful
output.

Note: This lesson describes how to submit job files to an installed device. Determine if you want
to actually submit the job to your press. If so, pay special attention to printing options outlined,
as they may not match options realistic to your own environment.

Important: For you to complete this lesson, a digital press and digital front end simulator must
be installed and configured in Prinergy. Based on naming preferences, names used in this lesson
won't be consistent with names used in your own environment.

Access the Prinergy for digital print training materials
Submit an input file to Digital Submit

View the document in Digital Direct

View the job in Prinergy Workshop

Create a Doclist

Plan the document

Submit the document to press

Delete the document

Delete the DoclList

Destroy the Prinergy job

Access the Prinergy for digital print training materials

Access the Prinergy for Digital Print training materials from your service representative, or
download them from Kodak's Partner Place web portal. Copy the lesson practice files to your
workstation before starting this lesson.

Note: The Partner Place web portal is located at https://partnerplace.kodak.com/.

1. In the Partner Place login window, type your e-mail address and password, and click
Continue.


https://partnerplace.kodak.com/

2. In the Partner Place window, in the Service & Support menu, select Search
Knowledgeable Answers.

In the Search box, type Pri nergy Wrkfl ow 8.0 Learni ng Resources.

Download the file Prinergy Activity QGui de to your desktop.

Once the download is complete, perform one of the following steps:

Copy the Prinergy Practice Files folder to your workstation.

Copy the Prinergy Practice Fil es folder to a local server accessible to your Prinergy
system.
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Submit an input file to Digital Submit

This task describes how to submit an input file to a digital press accessible in Digital Submit.
Once submitted, a Prinergy job is created and the input file and print instructions appear in
Digital Direct as a document.

Note: This task demonstrates submitting a static PDF input file. The same process described in
this task can be used to submit Variable Data Print file formats.

1. Start Digital Submit.
2. From your workstation, locate: Prinergy Practice Files / Digital Submt
3. Drag the Wl |I's Brochure. pdf to a target press in Digital Submit.
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Note: The name of the target digital press used in this example is HP SmartStream
Prodiction Pro simulator. Use a digital press that is native to your own environment.
4, In the New Job Submission dialog box, complete the following:
a. In the Create Job window, type XX Docunment (where <XX> represents your initials).
This defines the name of the Prinergy job.
b. In the Add Input Files window, verify that the correct input file was submitted.
c. In the Digital Press Settings section, complete the following:
d. verify the correct digital press is selected. In this example, the press is called HP
SmartStream Prodiction Pro simulator.
e. Select the print queue to use. In this example, the print queue is called SaddleStitch



f. click the Choose button and locate the HP default JDF template. Use the following
path:
Ar axi Hone\ Cr eoAr axi \data\ Di gi tal Pri nt Tenpl at es\ Hewl et t Par kar d\ def aul t.
j df

g. In the Set Job Properties section, select a Quantity of 1.

h. Using the calendar and time settings, enter Print By, Ship By, and Due By dates.

i. Add shipping information.

800 New Job Submission:XX_Document
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Creotivity5.pdf JUsers/gzmtyl/Desktop 1.65MB
+ il Copy to Job Folder
(7) | Cancel | | Submit |

. At completion, click the Submit button.



6. View the file submission process. At completion, click OK.
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View the document in Digital Direct

This task demonstrates how to locate the input file in Digital Direct. The input file is now
identified as a document (contains print content and print instructions).

1. Start Digital Direct.
2. In the default Ready To Print window, locate your document XX _Docunent .
If multiple documents are listed in the window, enter your initials in the Search window.

~ Ready To Print
Description: Shows all documents that are ready to be printed.
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3. Select your XX _Docunent . From the View menu, select Inspect.
Note: The Inspect feature can also be selected by right-clicking a document and choosing
Inspect or selecting the Inspect icon located at the top of the window.

4. In the Document Inspector window, verify that all information is correct. This window can
be helpful if you want to change document information, for example, print quantities.

5. Click Cancel.

View the job in Prinergy Workshop

This task demonstrates how to locate your Prinergy job in Workshop. Knowing how to access
your job is helpful if there are problems with the input file or the job requires additional
prepress work.

1. Start Workshop.
2. In Job Finder, locate the target digital press selected in Digital Submit.
3. Verify that your XX_Docunent is grouped with the target digital press.



4. Open your XX_Docunent job and verify that the Wel | s Brochure. pdf input file has been
added to the job.
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5. Close Workshop.
6. Minimize Job Finder.

Create a DoclList

This task describes how to create a DoclList in Digital Direct. DocLists are used to manually
organizing documents into groups, for example, Print on Monday, or Rush Jobs. To add a
document to a DoclList, simply drag the document to the appropriate DoclList.

1. From the File menu in Digital Direct, select Create DoclList.
2. In the DocList Name window, type XX DoclLi st (where <XX> represents your initials). Add
a description of the DoclList. Click Create.

DocList Name: XX_DocList

Description: Decuments that | process during my shift.

_ - -
@ Doclist contains 0 documents (_ Cancel ) E‘Ereﬂtt-a

3. View your Doclist in the DOCLISTS column.
4. In the Ready To Print window, select your document XX _Docunent and drag it to your
DoclList XX_Doclist.
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Your document is now displayed in three windows:

© All Documents—displays every document in the system

O Ready To Print—displays all documents with a status of Ready To Print
O XX_DoclList—displays all documents manually placed here

Plan the document

In this task, you will plan how your document is submitted to the target digital press. Planning
includes verifying or selecting a digital press, placing the document in priority, splitting the
document to print on multiple presses if required, and scheduling when the document will

actually print on press.

1.
2. From the Documents menu, select Plan for Press. Note that the status of the document

In your XX_DoclList, select XX Docunent .

is changed to Planned.

Note: You can also select the Plan for Press process by right-clicking a document and
choosing Plan for Press or selecting the Plan icon located at the top of the window.
From the Presses list, select the target press used in Digital Submit. In this example, the

target press is called HP SmartStream Production Pro simulator.
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From the Presses list, double-click the press HP SmartStream Production Pro
simulator. This opens the Press Speed dialog box.

Use this dialog box to describe the printing speed for a digital press. These settings are
used by Digital Direct only to estimate print times; they do not affect the speed of the
digital press.

HP SmartStream Print Server: HPSSPP46

Default Speed: . 4GB{].I§I (surfaces per hour)

Duplex Documents Run At: 50 |§| % speed

[ ?‘ | . Cancel | | Apply -

. In the Planned tab for press HP SmartStream Production Pro simulator, select your
XX_Docurent . Using the arrows on the right side of the window, move your document up
and down the list. This sets the priority of a document in a list.

. View the Capacity bar at the bottom of the Planned tab. The Capacity bar identifies how
many jobs can be safely scheduled to that press in a specified amount of time.

. Click the Target icon in the Capacity bar. Enter 6 hours.

1] '_Il':n.rsl
e

Lapaiby: | LIl
L2 hours g Target icon e

Double-click your XX_Document to view the Document Inspector window. Change the
Print Quantity from 1 to 2000. Click OK.

. The Capacity bar changes from green to red, signifying that the press has been "over-
scheduled" and cannot print 2000 copies within a six hour period. In this case, scheduling
will need to be modified.

6.0 hours |
Capacity: | LL I | | @S
12.3 hours J




The Capacity bar is an indicator tool that helps you successfully schedule multiple
documents to print in a selected amount of time.

10. Double-click your XX _Docunent to view the Document Inspector window.

11. Change the Print Quantity from 2000 to 1.

12. Click OK.

Submit the document to press

In this task you will submit the document to the target digital press and monitor the printing
process.

1. In the Planned tab, select XX_Document. From the Documents menu, select Submit
to Press.
Note: The Submit to Press process can also be selected by right-clicking a document and
choosing Submit to Press or selecting the Submit icon located at the top of the window.
2. In the Active tab, monitor the RIPing and printing of the document.
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3. In the Storage tab, check the status of the printed document.

HP SmartStream Print Server: HPSSPP46 Press Status: G}
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Delete the document

At completion of a successful printing process, you may decide to keep the document available
in the system, archive the job components, or simply remove the document from Digital Direct.
How documents are managed varies. The following tasks describe how to remove a document
from Digital Direct.

1. From the Done tab, right-click your XX_Document and select Delete Document.

2. Verify that the document has been removed from the All Documents list and your
XX_Doclist.

Delete the DoclList
In this task, you will remove the DoclList that you created.

1. From the DOCLISTS list, right-click your XX_DocList and select Delete.



Destroy the Prinergy job

In this task, you will destroy the Prinergy job created as part of the input file submission
process using Digital Submit.

1. In Job Finder, locate the target digital press used in Digital Submit.
2. Right-click XX_Document and choose Destroy Entire Job.
3. Enter a user name and password. Click the Destroy button.

Submit multiple input files to a digital press and use a Smart
DoclList to organize them tasks

You want to submit multiple input files to a digital press and use a Smart DoclList to organize
them. In this scenario, print quantities will be split, and a document will be changed to a
different target press, and reprinted. At completion, documents will be planned, submitted to
press, monitored, and removed following successful output.

The following procedures describe how to complete this lesson.

Create a Smart DoclList in Digital Direct
Submit an input file to Digital Submit
Split document print quantities

Change a target press

Reprint one document

Delete documents

Delete Smart DoclList

Destroy Prinergy job

Create a Smart DoclList in Digital Direct

In this task, you will create a Smart Doclist to automatically organize your documents based on
a defined criteria. A Smart DoclList defines the criteria that automates how documents are
organized once they enter Digital Direct.

1. From the File menu in Digital Direct, select Create Smart DoclList.

2. In the Smart DocList Name box, type XX_Smart DocLi st (where <XX> is your initials).
Add a description of the Smart DoclList.

3. Using the Criteria list, select: Name > contains > and enter: XX (where XX is your
initials). Click Create.
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4, View your XX_

@eno

Server: matt-pri
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Smart Doclist located in the SMART DOCLISTS column.

Smart Doclist: XX_Smart DocList
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Submit input files to Digital Submit

In this task, you will submit two input files to a digital press. Each input file will be uploaded to
Digital Direct as independent documents, but both documents will belong to the same Prinergy

job.

1. From your workstation, locate: Prinergy Digital

Print Practice Files/Digital

Submi t
2. Drag the following input files to a target HP digital press in Digital Submit:

Type Brochure. pdf

® Wells Brochure. pdf
Note: The name of the target digital press used in this example is HP SmartStream
Production Pro simulator. Use a digital press that is native to your own environment.
3. In the New Job Submission dialog box, complete the following:

a.

b.
c. In the Digital Press Settings section, complete the following:
d.

—h

In the Create Job box, type XX Smart Li st Docunents (where <XX> is your
initials). This defines the name of the Prinergy job.
In the Add Input Files box, verify that the correct input files were submitted.

verify the correct digital press is selected. In this example, the press is called HP
SmartStream Production Pro simulator

select the print queue to use. In this example, the print queue is called SaddleStitch
click the Choose button and locate the HP default JDF template. Use the following
path:

Ar axi Hone\ Cr eoAr axi \ dat a\ Di gi t al Pri nt Tenpl at es\ Hew et t Par kar d\ def aul t .

j df

. In the Set Job Properties section, select a Quantity of 6.

Using the calendar and time settings, enter Print, Ship, and Due dates.

. Add shipping information.



® 00  New]ob Submission:XX_SmartList Documents
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4. At completion, click the Submit button.

5. In Digital Direct, open your XX_Smart DoclList. Verify that the input files were
automatically placed here.
Based on the name criteria defined in your Smart DocList, and the naming conventions
used for your Prinergy job (XX), the system automatically sorted the documents into your
Smart Doclist based on that criteria.

v XX_Smart DocList
Description: List recognizes name criteria.

Summary: Show documents which match the following criterion:
Name contains “XX"

Name State JDF Amount Neo. Pages Target Press Print Duration  Print
XX_SmartList Documents [Type B... (Ready To Print 6 8 HPSSPP46 1 minute Toda
XX_SmartList Documents [Wells... (@Ready To Print [ 8 HPSSPP46 1 minute Toda

The documents are now displayed in 3 windows:

© All Documents—displays every document in the system
© Ready To Print—displays every document with a status of Ready to Print
© XX_Smart DoclList—displays documents that match a defined criteria

Split document print quantities

In this task, you will split the print quantities of a document into 2 parts. Each part will be
printed on a different press. This is beneficial when load balancing is required to shorten the
print time.

Documents can also be split and printed at different times of the day. This is beneficial when
needing to add flexibility to your daily scheduling process.

1. From your XX_Smart Documents window, select the XX_Smart Documents (Type
Brochure.pdf) document. Note there are 6 copies to print.

2. From the Documents menu, select Split (or right-click the document).

3. In the Split dialog box, verify that the document is splitting into 2 parts. Identify which
target press will be used for each part. Identify which print queue will be used for each
target press. Click Split.

Note: For the purpose of this example, one press will be identified as HP SmartStream
Production Pro simulator and the other press will be identified as HP SmartStream
Production Pro simulator:HP2. The print queue name for each press is called
SaddleStitch. This task requires that two digital presses be available.



M 0 0O Split: ¥XX_SmartList Documents [Type Brochoure.pdf]

Split document into: 2 |5| parts

Copies: 3|[5]

Name: | XX SmartList Documents [Type Brochoure.pdf]
Target Press: | HPSSPP46 =

-

Copies: 3(+]

Name: | XX SmartList Documents [Type Brochoure.pdf]-2

2

Target Press: | wfc-polaris2 =

(7) Cancel Split

4. View the split documents in your XX_Smart DocList window. Note the quantity of each
document has changed to 3.

v XX_Smart DocList
Description: List recognizes name criteria.

Summary: Show documents which match the following criterion:
Name contains "XX"

Name A State JOF Amount MNo. Pages Target Press
XX_SmartList Documents [Type Brochoure.pdf] (& Ready To Print 3 8 HPSSPP46
XX_SmartList Documents [Type Brochoure.pdf]-2 @ Ready To Print 3 8 wfc-polaris2
XX_SmartList Documents [Wells Brochour.pdf] (@ Ready To Print 6 8 HPSSPP46

5. Select both Type Brochure.pdf documents. Right-click one of the selected documents and

choose Plan for Press.
6. From the Presses list, select the target press HP SmartStream Production Pro
simulator.

HP SmartStream Print Server: HPSSPP46

. Plann locs, 2 minutes| & Production (0 docs) Completed (0 docs) I
Name No. Pages No. Copies Surfaces Print Duration
X¥_SmartDoc List [Type Brochoure.pdf] 8 3 24 1 minute
XX_SmartDoc List [Wells Brochour.pdf] 8 [ 48 1 minute

7. In the Planned tab, select the document XX_Smart Documents (Type Brochure.pdf).

Click the Submit icon located at the top of the window.

In the Production tab, monitor the RIPing and printing of the document.

In the Storage tab, check for the completion of the printing process.

10. From the Presses list, select the target press HP SmartStream Production Pro
simulator:HP2.

0 ®



HP SmartStream Print Server: wfc-polaris2 Press §

(7 Planned (1 doc, T minute) | 0 Production (0 docs) Completed (5 docs)

Name No. Pages No. Copies Surfaces Print Duration
XX_SmartDoc List [Type Brochoure.pdf]-2 B 3 24 1 minute

11. In the Planned tab, select the document XX_Smart Documents (Type Brochure.pdf)
-2. Click the Submit icon located at the top of the window.

12. In the Production tab, monitor the RIPing and printing of the document.

13. In the Storage tab, check for the completion of the printing process.

Change a target press

In this task, you will change the target press that a document was intended to print on.
Changing a target press is helpful if the originating target press goes offline for maintenance
issues.

1. From your XX_Smart Documents window, select XX_Smart Documents (Wells
Brochure.pdf). View the current target press. In this example, the target press is HP
SmartSteam Production Pro simulator.

2. From the Documents menu, select Change Target Press. Select a new target press. In
this example, the new target press is HP SmartStream Production Pro simulator:HP2.
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3. View the press change in your Smart DocList window.

4. Select XX_Smart Documents (Wells Brochure.pdf) and click the Plan icon located at
the top of the window.

5. From the Presses list, select the new target press HP SmartStream Production Pro
simulator:HP2.



6. In the Planned tab, select your document. Click the Submit icon located at the top of the
window.

7. In the Production tab, monitor the RIPing and printing of the document.

In the Storage tab, check for the completion of the printing process.

Select the XX_Smart Documents (Wells Brochure.pdf) document and click the History

icon located at the top of the window. View the submission processing history. Close the

Process History window.

0 ®

Reprint one document

In this task, you will reprint 1 document. The reprint feature is beneficial when additional copies
of a printed document are required.

1. From the Storage tab, select the XX_Smart Documents (Wells Brochure.pdf)

document.

From the Documents menu, select Reprint (or right-click the document).

3. In the Reprint dialog box, select 2 copies to be printed. Click Reprint.

4. From your XX_Smart DocList window, select XX_Smart Documents (Wells Brochure.
pdf) copy. Click the Plan icon at the top of the window.

N

¥ XX_Smart DocList
Description: List recognizes name criteria.

Summary: Show documents which match the following criterion:
Name contains "XX"

Name State JDF Amount | No. Pages Target Press

XX¥_SmartDoc List [Type Brochoure.pdf]-2 &2 Post Press 3 8 HPSSPP46
X¥_SmartDoc List [Type Brochoure.pdf] &2 Post Press 3 8 HPSSPP46
X¥_SmartDoc List [Wells Brochour.pdf] 2 Post Press 6 8 HPSSPP46

5. From the Presses list, select the target press HP SmartStream Production Pro

simulator.

6. In the Planned tab, select the document. Click the Submit icon located at the top of the
window.

7. Monitor the reprint process in the Production tab.

8. View the completed reprint process in the Storage tab.

Delete documents

At completion of a successful printing process, you may decide to keep the document available
in the system, archive the job components, or simply remove the document from Digital Direct.
How documents are managed varies. The following tasks describe how to remove a document
from Digital Direct.

1. From the Presses list, select the target press HP SmartStream Production Pro

simulator.
2. In the Storage tab, select XX_Smart Documents (Type Brochure.pdf).



HP SmartStream Print Server: HPSSPP46 Press Status: aE

Planned (1 doc, 1 minute) Production (0 docs) | Completed (2 docs) )
Name Submitted From Completed

XX_SmartDoc List [Type Brochoure.pdf]-2 Today 11:27 AM Prinergy | araxi Today 11:27 AM
XX_SmartDoc List [Type Brochoure.pdf] Today 11:27 AM Prinergy / araxi Today 11:27 AM

Right-click the document and choose Delete Document.

From the Presses list, select the target press HP SmartStream Production Pro
simulator:HP2.

5. In the Storage tab, select documents:

® XX_Smart Documents (Type Brochure.pdf)

® XX_Smart Documents (Wells Brochure.pdf)

W

HP SmartStream Print Server: wfc-polaris2 Press Status: - ogri

IPlanned (1 doc, 1 minute) Production (0 docs) ‘Completed (2 docs) i

Name Submitted From Completed
XX_SmartDoc List [Type Brochoure.pdf] Today 11:27 AM Prinergy / araxi Today 11:27 AM
XX_SmartDoc List [Wells Brochour.pdf] Today 11:27 AM Prinergy / araxi Today 11:27 AM

6. Right-click the documents and choose Delete Document.
7. Verify that the documents have been removed from the All Documents list and the
XX_Smart Doclist.

Delete Smart DoclList
In this task, you will remove the Smart DocList that you created.

1. From the SMART DOCLISTS list, right-click your XX_Smart DocList and select Delete.

Destroy Prinergy job

In this task, you will destroy the Prinergy job created as part of the submission process using
Digital Submit.

1. In Job Finder, locate the target digital press used in Digital Submit.
2. Right-click XX_Smart Documents and choose Destroy Entire Job.
3. Enter a user name and password. Click the Destroy button.
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